Click here for production status of specific part numbers.

MAX32010 Evaluation Kit

General Description

The MAX32010 evaluation kit (EV kit) is a fully
assembled and tested printed circuit board (PCB)
design that evaluates the functionality of device power
supply (DPS) IC MAX32010, which has 25V span output
voltage and programmable current ranges up to 1.2A.

The MAX32010 EV kit contains a microcontroller (MCU)
that translates between the SPI interface and USB to
allow the user to configure internal registers and modes
with graphical user interface (GUI) software running on
a PC. The EV kit includes Windows® 10-compatible
software that provides a simple GUI for configuration of
all the MAX32010 registers through SPI. The EV kit is
fully assembled and tested at the factory.

This document provides a list of equipment required to
evaluate the device, a straightforward test procedure to
verify functionality, a description of the EV kit circuit,
component list, circuit schematic, and artwork for each
layer of the PCB. The MAX32010 EV kit PCB comes with
a MAX32010DCCQ+ installed.

EV Kit Top View

Evaluates: MAX32010

Features

Easy Evaluation of the MAX32010 EV kit

e On-Board Voltage Reference (MAX6126)

e On-Board DACs for Level Setting

e On-Board ADC for Measurements

e On-Board Regulators Generate All the Required
Voltages from +12V

e USB Interface

o Headers for External SPI and DACs

e Proven PCB Layout

¢ Includes Heatsink and Fan

o Fully Assembled and Tested

Ordering Information appears at end of data sheet.
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MAX32010 Evaluation Kit Evaluates: MAX32010

Quick Start
Required Equipment

This section lists the recommended test equipment to verify operation of the MAX32010. It is intended as a guide only
and substitutions are possible.

MAX32010 EV kit
¢ Windows PC (Windows 10) with one USB2.0 port
e Triple Output DC power supply

+ +12V/1.5A

+ -12V/1.5A

+ +5V/500mA

¢ Digital voltmeter and ammeter

Software and Drivers

The MAX32010 EV kit is used in conjunction with the Arm® Cortex®-M4 processor with FPU MAX32625PICO application
platform to control the device through a software application or GUI.

Install the MAX32010 EV Kit GUI Software

Download the MAX32010 EV kit software from the Maxim Integrated website. See the Appendix section for detailed
instructions to install the EV kit software. The installation process takes less than 10 minutes after downloading the
software package.

Procedure

1)

Place the MAX32010 EV kit on a nonconductive surface to ensure that nothing on the PCB gets shorted to the
workspace.

2) Set all jumpers in their default position as mentioned in Table 1.

3) Connect the USB cable from PC to EV Kkit.

4) Apply +12V to VCC, -12V to VEE, and +5V to VDD.

5) Start the MAX32010 EV kit software by opening its icon in the Start | Programs menu. The EV kit software main
window appears, as shown in Figure 1.

6) In the Max32010 Settings group box, click on the FV radio button in the Measurement Mode group box and click
Write button.

7) Inthe DAC Settings group box, change the voltage for VIN to +1V and click Write button.

8) Check that the output voltage at DUT_NODE is close to +1V. Figure 1 shows the MAX32010 EV kit quick start

settings.
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MAX32010 Evaluation Kit Evaluates: MAX32010

Detailed Description of Software

The main window of the evaluation kit software is shown in Figure 1.

The MAX32010 GUI is organized into four group boxes for all level setting registers and control signal settings, along with
the File menu to save and load all these settings.

@ MAX32010 Evaluation Kit - 25V, 1.2A Device Power Supply for Industrial & Test Applications — O X
File Options About TEST
Max32010 Settings DAC Settings
VGA Gain +1 @ VIN Level Voltage =~ 1.00 *
Range 1.2A +
. e 10SI Level Voltage 0.00
FMODE
000 *
CLEN ® |IOSV Level Voltage =
Measurement Mode RESERVED @ CLH Level |0x0800 \Voltage 0.00 *
i- v HIZFR +
™ i e CLL Level Voltage @ 0.00
L J FV +
) o, o ITHHI Level Voltage = 0.00 *
LCOMP1 @ ITHLO Level Voltage =~ 0.00 *
MP
Ssaie WRITE
BCOMP1
+ Auto Write
BCOMPO
MAX32010 Signals Data Flow Control
WRITE
HIZMPB 0b11 ;
V| Auto Write IDDQSEL
Console
4:25:37 PM Write 0x5800to CLL A
4:25:37 PM Write 0x4800to ITHHI
4-9R-27 PM Writa M RN A ITHIN

Figure 1. MAX32010 EV Kit Quick Start Settings
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MAX32010 Evaluation Kit Evaluates: MAX32010

1)

2)

MAX32010 Settings: The MAX32010 can be quickly configured through control register settings. An 18-bit word
programs the MAX32010.

The Measurement Mode group box is a quick way to set the MAX32010 to force voltage (FV), force current (Fl),
force current as a slave device (FI Slave), or place into high impedance (Hi-Z). Bit settings are automatically changed
to match the mode settings as follows:

¢ In Hi-Z mode, all the bits in control register are unchecked.

e In Fl Slave mode, FMODE bit is checked and all other bits are unchecked.

e InFV mode, HIZFRCB bit is set and all other bits are unchecked.

e In FI mode, both HIZFRCB and FMODE bits are set and all other bits are unchecked.

The Measurement Mode group box provides the measured voltages at IMEAS and VMEAS pins of the MAX32010.
Table 1 shows the settings and functionality of these bits in the GUI:

Table 1. Settings and Functions of the GUI Bits

SETTING FUNCTION
VGA Gain This horizontal scrollbar controls the gain and polarity of the variable gain amplifiers (VGA).
Range This horizontal scrollbar controls the full-scale current range for either FI (force current)

or MI (measure current) mode.

FMODE This checkbox selects DPS mode (FV, FI, Fl slave, and high impedance).
CLEN This checkbox enables or disables the voltage and current clamps.
HIZFRCB This checkbox along with FMODE selects DPS mode (FV, FI, Fl slave, and high impedance).
HIZMSB This checkbox controls the measure output’s high-impedance state.
HIZCMPB This checkbox controls the comparator output’s high-impedance state.
LCOMP1 and LCOMPO These checkboxes enable or disable compensation capacitors.
BCOMP1 and BCOMPO These checkboxes enable or disable bypass capacitors.

MAX32010 Signals and Data Flow Control: HIZMPB and IDDQSEL are signals that can be used to control the
functionality of the MAX32010. The HIZMPB signal is shared in functionality with the HIZMSB bit and internally both
bits are ANDed. It is used either to enable the measurement output or to put the measurement output in the high-
impedance state. While in FV mode asserting digital input, IDDQSEL switches the DPS to the minimum current range
(range D) and enabling the IDDQ test mode.

Data flow control bits specify how data transfers from the shift registers to the input and DPS register of the

MAX32010. Refer to Serial Interface Data Flow Control Bits section in the MAX32010 data sheet for more details.
Table 2 shows the options available for controlling the data flow:

Table 2. Data Flow Control Settings

SETTING DESCRIPTION
00 Input and DPS registers remain unchanged
01 DPS registers get loaded from input register
10 Input registers get loaded from shift register
11 Both DPS and input registers get loaded from shift register
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MAX32010 Evaluation Kit Evaluates: MAX32010

3)

4)

5)

DAC Settings: The MAX5322 outputs voltages for the MAX32010 device. The output voltages are set by entering
values in the corresponding edit boxes and pressing Enter on the keyboard or clicking the Write button in this specific
group box. The edit boxes accept the value of the voltage. Changes in the DC Level edit boxes automatically change
the hexadecimal values in the DAC Setting edit boxes and vice versa. Analog voltages (VIN, 10SI, IOSV, CLH, CLL,
ITHHI, and ITHLO) are set by the MAX5322 and appear as the input levels for the MAX32010.

AutoWrite: The AutoWrite checkboxes can be checked to have the software automatically perform write operations.
This feature allows the user to change settings and have them updated without pressing the WRITE buttons. There
is an AutoWrite checkbox for writing to the MAX32010 and DACs. Each device can independently perform
autowriting. AutoWrite is disabled by default.

Menu Options: The Save Configuration option in the File menu saves the current configuration in the MAX32010
EV kit software and the Load Configuration option in the File menu loads the saved configuration in the MAX32010
EV kit software. The Save Log option in the File menu saves the data log in the console of the MAX3210 EV kit
software.

The Select Port in the Options menu enables the user to connect to the desired COM port. The Reset Settings in
the Options menu resets all the current settings in the MAX32010 EV kit software.

Detailed Description of Hardware

The MAX32010 EV kit is a fully assembled and tested circuit board for evaluating the MAX32010 device power supply.
The MAX5322 DAC provides the analog voltages to the MAX32010 DPS. The MAX32625PICO microcontroller controls
SPI data transfer with both MAX32010 DPS and MAX5322 DACs. The various test points are available for different signals
and LEDs to indicate status information. The EV kit uses banana plugs for the outputs and inputs because of their high-
current capability. Fan header is provided to power the fan to cool the MAX32010 DPS. Operating without the fan does
not damage the MAX32010 DPS even at high current because it has a thermal shutdown feature that turns off the IC
when the die temperature exceeds the thermal limit. The thermal limit reaches quickly without airflow from the fan. Below
Figure 2 shows the block diagram of the MAX32010 EV kit.

POWER SUPPLY

4 x VREF

(MAX6126) MAX32625PICO

BANANA JACK A i

L y SPI

vee VDAC1 AND VDAC2
2xLDO
Q (MAX16910) 4xDACs MAXs2010

(MAX5322) (HEATSINK

Y

AND FAN)

VEE

TO MAX32010

v

OPAMP FOR GAIN FAN VOLTAGE
VDD SETTING
oo w (MAX4424)
» -
(MAX38903)
TO MAX32010

Figure 2. MAX32010 EV Kit Block Diagram
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MAX32010 Evaluation Kit

Powering the Board

The MAX32010 EV kit is powered by +12V, -12V, and +5V. On-board regulators generate DAC supply voltage (+11V)
and VL (+3V). External power supplies are used by default, but changing the jumper position on J7, J8, and J9 allows
the user-supplied power. See Table 3 for jumper configurations. User-supplied power is useful when isolating the supply
current to individual devices. The USB-to-SPI circuitry is fully powered by USB connections and can be used without
banana jack supplies. Power is always present before the software runs.

On-Board Headers (Interface) and Test Points
Table 3 shows the jumper header, shunt position, and description.

Evaluates: MAX32010

Table 3. Jumper Settings

JUMPER SHUNT POSITION DESCRIPTION

J1 Open* Connects SENSE to DUT_NODE

J2 Open* Connects DUTGSNS to GND

J3 Open* Connects VTHR to GND

14 Open* Provides various signals (AMPOUT, IPAR, VINS, EXTSEL, and VTHR) on the header
for external connection

J5 1-2* Turns on the fan on heatsink

Ju12 2-3 Turns off the fan on heatsink

J6 Open* Connects to 5V supply of fan

J7 1-2* Connects VCC from power jack to VCC of the MAX32010

J8 1-2* Connects VEE from power jack to VEE of the MAX32010

J9 1-2* Connects VDD from power jack to VDD of the MAX32010

Ji1 Open* MAX32625PICO signals (TEMP, ILIMLO, ILIMHI, and HITEMP)

112 Closed* MAX32625PICO SPI signals (LOADB, SCLK, DIN, DOUT, SS_MAX9959, SS_ADC,
SS_DACS3, and SS_DAC1)

J13 Closed* MAX32010 SPI signals (LOADB, SCLK, DIN, DOUT, SS_MAX9959)

J14 Closed* MAX32010 DAC signals

J15 Closed* MAX5322 DAC signals

*Indicates default jumper state.

Table 4. Test Points

JUMPER DESCRIPTION
VCC Power Input: Apply positive voltage from DC power supply in range of +12V to +18V
VEE Power Input: Apply negative voltage from DC power supply in range of -12V to -15V
VDD Power Input: Apply positive voltage from DC power supply +5V
VDAC1, VDAC2 LDO output voltage for DACs
VL LDO output voltage for VL power domain of the MAX32010

OUT_DAC1, OUT_DAC2,
OUT_DAC3, OUT_DAC4

DAC output voltage

RA, RB, RC, RD

Test point to measure the voltage across sense resistors, connected to the MAX32010 for
different current ranges

DUT_NODE Range A/B/C/D output, to which load resistor gets connected
VTHR Threshold voltage input. Sets the input logic threshold level of all digital inputs
EXTSEL External Select Output. Selects the external range

www.maximintegrated.com
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MAX32010 Evaluation Kit

Evaluates: MAX32010

HITEMP Temperature Monitor Output. Temp outputs a voltage proportional to die temperature 10mV/K
ILIMHL ILIMLO Low-Current and High-Current Limit Output. This output is triggered if the load current is above
' ILIMHI or below ILIMLO
AMPOUT Main Amplifier Output. Drives the external buffer when in external range mode

*Indicates default jumper state.

Ordering Information

PART

TYPE

MAX32010EVKIT#

EV Kit

#Denotes RoOHS compliance.

MAX32010 EV Kit Bill of Materials

ITEM | REF_DES DsgD QTY MFG:ART MANUFACTURER | VALUE | DESCRIPTION COMMENTS
TEST POINT; PIN
AMPOUT, DIA=0.125IN;
EXTSEL, TOTAL
HITMP, LENGTH=0.445IN:
TPO- BOARD
1 | TP13, - 14 | 5012 KEYSTONE N/A HOLE=0.063IN;
TP17- WHITE;
TP20, PHOSPHOR
VRXP, BRONZE WIRE
VTHR SILVER PLATE
FINISH:
C1210C106
K3RACIGR CAPACITOR; SMT
M32DR71E1
06K GON32 (1210); CERAMIC
c1C3 enr1E106 | KEMETMURATA; CHIP; 10UF; 25V
2 ’ - 4 MURATA;TDK:MU | 10UF | TOL=10%;
c76 A57:CGA6P ,
oRiios | RATA MODEL=; TG=-55
DEGC TO +125
K250AC,GC DEGC; TC=X7R
J32ER71EL ’
06KA18
GRM188R71
E105KA12:C
GA3E1X7R1
E105K: TMK
107B7105K CAPACITOR; SMT
3 gsg’ cr4, - > | M188R71EL \T(;J_gi:\\'('gvx’MURA Uk TOL=10%; TG=-55
05KAB4:C16 | /D DEGC TO +125
08X7R1E10 ' DEGC: TC=X7R
5KOB0AE:C
GA3E1X7R1
E105K080A
C
C0603C102 1000P | CAPACITOR; SMT
S - 2 | kicacicie | KEMET.TDK F (0603); CERAMIC

www.maximintegrated.com
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Evaluates: MAX32010

ITEM | REF_DES DE'F/,D oty | MFG : ART | \JANUFACTURER | VALUE DESCRIPTION COMMENTS
08C0G2A10 CHIP; 1000PF;
2KOB0AA 100V; TOL=10%;

MODEL=CO0G; TG=-
55 DEGC TO +125
DEGC; TC=
C1608X5R1 CAPACITOR; SMT
E475KO30A (0603); CERAMIC
5 | C6C9 - 4 |c TDK:MURATA a7up | CHIP: 4.7UF 25V;
C63, C65 ’ ' ' TOL=10%; TG=-55
GRM188R61
EATSKELL DEGC TO +85
DEGC; TC=X5R
C1608X5R1
E106MOS0A
C;CL10A106 CAPACITOR; SMT
c10, C12- MABNRNC; | Loy o\ SUNG (0603); CERAMIC
GRM188R61 CHIP; 10UF; 25V;
6 C16, C25- - 18 ELECTRONICS;MU | 10UF
e EL0BMA73:Z | o or v im TOL=20%; TG=-55
RB18ARG1E " DEGC TO +85
106ME01;G DEGC; TC=X5R
RT188R61E
106ME13
C0603C473 CAPACITOR; SMT
K5RAC;GR
(0603); CERAMIC
M188R71H4 CHIP; 0.047UF;
; o1t ) | | 73KABLGC | KEMETIMURATA; | 0.047U | oo o7
M188R71H4 | MURATA;TDK F At
MODEL=X7R; TG=-
73KA55;CG
55 DEGC TO +125
A3E2X7R1H DEGC: TCoXTR
473K080AA T
CAPACITOR; SMT
gg:gig’ (0603); CERAMIC
' 06033C104J CHIP; 0.1UF; 25V;
8 ggg' gsg: i 28 | AT2A AVX O1UF | toL=50: TG=-55
iy DEGC TO +125
DEGC; TC=X7R
CAPACITOR; SMT
(0603); CERAMIC
GCM188R71 3300P | CHIP; 3300PF; 50V;
o €49 i b | haaokagy | MURATA F TOL=10%; TG=-55
DEGC TO +125
DEGC; TC=X7R
€0603C223 CAPACITOR; SMT
K5RAC;GR
(0603); CERAMIC
M188R71H2 CHIP; 0.022UF;
23K;C1608X | KEMET;MURATAT | 0.022U L '
10 | C50 - 1 50V; TOL=10%;
7R1H223K0 | DK;MURATA F
TG=-55 DEGC TO
80AA;GCJ18
+125 DEGC;
8R71H223K TOoXTR
A01 B
CAPACITOR; SMT
C51, C54, CCOB03KRX (0603); CERAMIC
11| ceo 3 | 7roBB3a1 | TACEO 330PF | cHip: 330PF: 50v:

TOL=10%; TG=-55

www.maximintegrated.com
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MAX32010 Evaluation Kit

Evaluates: MAX32010

ITEM | REF_DES DE'F/,D QTY MFG:ART MANUFACTURER | VALUE | DESCRIPTION | COMMENTS
DEGC TO +125
DEGC; TC=X7R
CAPACITOR; SMT
o o
12 | cs2 o6 ] , | 00-472KNE; | VENKEL 4700 | S0 o
' GRM188R71 | LTD.;MURATA F ’
7K AOL MODEL=; TG=-55
DEGC TO +125
DEGC; TC=X7R
CAPACITOR; SMT
0 commuc.
00103JNP;C | VENKEL ORI SOV,
13| css - 1| 0603c10835 | LTD:KEMET 0.01UF | TOL=5%;
A ’ MODEL=X7R; TG=-
55 DEGC TO +125
DEGC; TC=+/
CAPACITOR; SMT
0 o
K5RAC; KEMET;VENKEL | 1500P ' OOV
14 | cs5,C58 - 2 | cosoarrs | LTD - TOL=10%:;
o1 MODEL=; TG=-55
DEGC TO +125
DEGC; TC=X7R
CAPACITOR; SMT
(0603); CERAMIC
06035C101J CHIP; 100PF; 50V:;
15 | c57,C59 - 2 | AVX 100PF | 0 e Tomss
DEGC TO +125
DEGC; TC=X7R
CAPACITOR; SMT
C0B03COCS (0603); CERAMIC
00-271INE; | VENKEL CHIP; 270PF; S0V
16 | c61,C62 - 2 | GRW1885C1 | LTD-MURATA 270PF | TOL=5%; MODEL=;
AN TG=-55 DEGC TO
+125 DEGC;
TC=C0G
DIODE; LED;
TANDARD; RED:
17 | DS1-DS3 3 | LTST Iéll_TEEé?,F\:ONlcs ETSEC EMT oe03); RED
; - C190CKT | e PIV=5.0V; IF=0.04A:;
' -55 DEGC TO +85
DEGC
DIODE; LED;
STANDARD:
DS4, DS5 LTST- | YELLOW-GREEN;
Tt LTST- LITE-ON '
DS6, C193K | SMT (0603); (DS4,DS5:GR
18 | Doa. - 7 §i93KGKT- ::;\ILCECTRONICS kT | PIv=Lov: EEN)
DS11 : 5A IF=0.005A; -55
DEGC TO +85
DEGC
RECEPTACLE;
DUT_NO JACK; BANANA:
19 | O¢ Tpia - 2 | 5754 KEYSTONE 5754 | §'203iN [5.2MM]
DIA X 0.218IN

www.maximintegrated.com
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MAX32010 Evaluation Kit Evaluates: MAX32010

DNI/D MFG PART

ITEM REF_DES NP QTY MANUFACTURER | VALUE DESCRIPTION COMMENTS

#

[5.5MM] L;
0.203D/0.218L;
NICKEL PLATED
BRASS

INDUCTOR; SMT
MPZ1608S2 (0603); FERRITE-
20 FB1-FB6 6 21ATAO0O oK 220 BEAD; 220; TOL=+/-

25%; 2.2A

EVK KIT PARTS;
GND, MAXIM PAD; WIRE;
TEMP, MAXIM | NATURAL,; SOLID;
21 vee, - 5 9020 BUSS WEICO WIRE PAD WEICO WIRE:
VDD, VEE SOFT DRAWN BUS

TYPE-S; 20AWG

TEST POINT; PIN
DIA=0.1IN; TOTAL
HITEMP, LENGTH=0.3IN;
ILIMHI, BOARD

22 ILIMLO, - 7 5000 KEYSTONE N/A HOLE=0.04IN; RED;
RA, RB, PHOSPHOR

RC, RD BRONZE WIRE
SILVER PLATE
FINISH;

CONNECTOR;
MALE; THROUGH
HOLE;

J1-33, J6- PCC02SAA PCC02 | BREAKAWAY;

23 J9 i / N SULLINS SAAN STRAIGHT
THROUGH,; 2PINS;
-65 DEGC TO +125

DEGC

CONNECTOR;
MALE; THROUGH
SULLINS HOLE;

24 J4 - 1 ZBCO4DAA ELECTRONICS Ep)iiglll BREAKAWAY;
CORP. STRAIGHT; 8PINS;
-65 DEGC TO +125

DEGC

CONNECTOR;
MALE; THROUGH

25 J5 - 1 ZECO3SAA SULLINS Ziilc\)ls HOLE;
BREAKAWAY;

STRAIGHT; 3PINS

4 MACHINE

4- FABRICATED;
26 J10 - 1 151502UA77 I?\IONCC))I;/ATIONS l]-iil.?57012 HSINK; FAN SINK;
139 38.1MMX38.1MMX1

39 5.6MM ;

MACHINE
FABRICATED;
ROUND-THRU
HOLE SPACER; NO
THREAD; M3.5;
5/8IN; NYLON

27 MH1-MH8 - 8 9032 KEYSTONE 9032

www.maximintegrated.com Maxim Integrated | 10
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ITEM | REF_DES DE'F/,D qry | MFG : ART | MANUFACTURER | VALUE | DESCRIPTION | COMMENTS
RESISTOR; 0603;
ERJ- 390K OHM; 5%:
28 | R4,R7 - 2 | sobyizes | PANASONIC 390K | 00mput 0.10W:
THICK FILM
RESISTOR; 0603;
PNMOGO3ES 50K OHM; 0.1%;
29 | R5,R8 - 2| oozBs VISHAY DALE 50K 25PPM: 0150
THIN FILM
CRCW0603 RESISTOR; 0603;
R6, R9 VISHAY » JOUS,
30 1 - 4 | 10KOFK:ERJ , 10K 10K; 1%: 100PPM;
R36, R40 -3EKF1002 | DALEIPANASONIC 0.10W; THICK FILM
RESISTOR; 0603; 0
31 Eig'ilf;’ - 6 OC;)%%%OS VISHAY DALE 0 OHM; 0%; JUMPER;
’ 0.1W; THICK FILM
R14, R16,
R35, R39, CRCWOB03 | 1y RESISTOR; 0603;
32 | R42, R44, - 9 | 1KooFKERY | SO o | K 1K; 1%: 100PPM;
R47, R48, -3EKF1001 ' 0.10W; THICK FILM
R50
RESISTOR, 0603,
CRCW0603 22K OHM, 1%,
33 | R18-R25 - 8 | ookorK VISHAY DALE 22K L00PPML, 0.10W.
THICK FILM
SR reseTon
34 | R31,R33 - 2 DRALORIC:TE 10 7
PICRGP121 | o i = 100PPM; 0.75W:
OF10R THICK FILM
CRCW1206 fiif 1802_15_1206);
35 | R32, R34 - 2 :FL)R54FKEAH VISHAY 154 LOOPPMIDEGC:
0.75W
RESISTOR; 1210;
CRCW1210 100 OHM; 1%:
36 | R37,R38 - 2 | JoorEK VISHAY DALE 100 L0OPPM: 0.5
THICK FILM
RA1 RA3. TNPWOBOSL | 0o 0 Econ RESISTOR; 0603;
OKOBE; 10K OHM; 0.1%:
37 | R45, R46, - 5 SPEER 10K
g RN73LITTD | 2/ Eore o 25PPM; 0.1W;
10028 THICK FILM
ggg’:f)sgzzg RESISTOR, 0603,
' VISHAY;YAGEO: VI 3.3K OHM, 1%,
38 | Rs51 - 1 | 3FR- 3.3K
SHAY 100PPM, 0.10W,
073K3L:RK7 THICK FiLM
3H1J3301F
RESISTOR; 0603;
ERJ- 1K OHM; 5%:
39 | R53,RS5 - 2 | sopyiign | PANASONIC 1K 200PPNL 0.10W:
THICK FILM
CROWO0G03 RESISTOR, 0603,
40 | R54, R68 - 2 | 2k7orkERy | VISHAY 27K | 27K OHM, 1%,
“bkiaor | DALEPANASONIC 100PPM, 0.10W,

THICK FILM

www.maximintegrated.com
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ITEM

REF_DES

DNI/D
NP

QTY

MFG PART
#

MANUFACTURER

VALUE

DESCRIPTION

COMMENTS

41

R56, R57,
R60, R61

ERJ-
3EKF3481

PANASONIC

3.48K

RESISTOR; 0603;
3.48K OHM; 1%;
100PPM; 0.1W;
THICK FILM

42

R58, R59,
R62, R63

RNCPO603F
TD2K00

STACKPOLE
ELECTRONICS
INC.

2K

RESISTOR; 0603;
2K OHM; 1%;
100PPM; 0.125W;
THICK FILM

43

SU1-SU9

NPC02SXO
N-RC

SULLINS
ELECTRONICS
CORP.

NPCO02
SXON-
RC

CONNECTOR;
FEMALE; MINI
SHUNT; 0.100IN
CC; OPEN TOP;
JUMPER,;

STRAIGHT; 2PINS

44

TP1-TP4

3267

POMONA
ELECTRONICS

3267

CONNECTOR;
MALE;
PANELMOUNT;
STANDARD
UNINSULATED
BANANA JACK;
STRAIGHT; 1PIN

45

TP5, TP8,
TP22,
VDAC, VL

5005

KEYSTONE

N/A

TEST POINT; PIN
DIA=0.125IN;
TOTAL
LENGTH=0.35IN;
BOARD
HOLE=0.063IN;

RED; PHOSPHOR

BRONZE WIRE
SILVER PLATE
FINISH;

46

TP6, TP7,
TP21

5006

KEYSTONE

N/A

TEST POINT; PIN
DIA=0.125IN,;
TOTAL
LENGTH=0.35IN;
BOARD
HOLE=0.063IN;
BLACK;
PHOSPHOR
BRONZE WIRE
SILVER PLATE
FINISH;

47

U1, u2

MAX16910C
ATA8+

MAXIM

MAX16
910CA
TA8+

IC; VREG; 0.2A;
ULTRA-LOW
QUIESCENT

CURRENT; LINEAR

REGULATOR;
TDFN8-EP 3X3

48

u3

MAX38903A
ATB+

MAXIM

MAX38
903AA
TB+

EVKIT PART-IC,;
PKG. CODE:
T1033+1C; PKG.

OUTLINE NO.: 21-

0137; PACKAGE

www.maximintegrated.com
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ITEM

REF_DES

DNI/D
NP

QTY

MFG PART
#

MANUFACTURER

VALUE

DESCRIPTION

COMMENTS

LAND PATTERN:
90-0003

49

U4, US

MAX6126AA
SA50+

MAXIM

MAX61
26AAS
A50+

IC; VREF; ULTRA-
HIGH PRECISION;
ULTRA-LOW
NOISE; SERIES
VOLTAGE
REFERENCE;
NSOIC8 150MIL

50

ue, U7

MAX6126B2
1+

MAXIM

MAX61
26B21+

IC; VREF; ULTRA-
HIGH PRECISION;
ULTRA-LOW
NOISE; SERIES
VOLTAGE
REFERENCE;
UMAX8

51

us-ull

MAX5322EA
I+

MAXIM

MAX53
22EAI+

IC; DAC; +/-10V,
DUAL, 12-BIT,
SERIAL, VOLTAGE-
OUTPUT DAC;
SSOP28

52

uU13

MAX32625P
ICO

MAXIM

MAX32
625PIC
(0]

MODULE; BOARD;
MAX32625PICO
BOARD DESIGN
FOR MAX32625
ARM CORTEX-MA4F;
BOARD;
LAMINATED
PLASTIC WITH
COPPER CLAD;

53

ui4

MAXA44245A
UD+

MAXIM

MAX44
245AU
D+

IC; OPAMP; 36V;
PRECISION; LOW-
POWER; 90MICRO-
AMPERE; QUAD
OP AMPS;
TSSOP14

54

u15

MAX14759E
TA+

MAXIM

MAX14
759ET

IC; ASW; ABOVE-
AND BELOW-THE-
RAILS LOW ON-
RESISTANCE
ANALOG SWITCH;
TDFN8-EP

55

ui16

MAX1033BE
UP+

MAXIM

MAX10
33BEU
P+

IC; ADC; 4-
CHANNEL; +/-3 X
VREF
MULTIRANGE
INPUTS; SERIAL
14-BIT ANALOG-
TO-DIGITAL
CONVERTER;
TSSOP20

56

PCB

MAX32010

MAXIM

PCB

PCB:MAX32010

www.maximintegrated.com
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ITEM | REF_DES D:;“F/,D QTY MFG:ART MANUFACTURER | VALUE DESCRIPTION COMMENTS
QUALTEK 302501 | CONNECTOR; MALE; USB-A_MINI-
57 MISC1 DNI 1 | 3025010-03 | ELECTRONICS 0.03 B; USB 4P(A)/M - USB MINI
CORP 5P(B)/M; STRAIGHT; 36IN
DIODE, ZENER,
58 D1-D3 DNP 0 | 1N5250B g’;ﬁé’ghgumm 20V DO-35, Pd=0.5W,
Vz=20V@Iz=6.2mA
IC; PWRMOD; 25V
SPAN; 800
MAX32 ;
MAX32010D MILLIAMPERE
59 ut2 ) 0 CcCo+ MAXIM ?:g)PC DEVICE POWER
SUPPLY (DPS);
TQFP100-IDP
RL.R3 PACKAGE
60 R26.R30 DNP 0 | NA N/A OPEN | OUTLINE 0603
RESISTOR
01- SULLINS
61 J13 - 1 PBCO5SAA | ELECTRONICS 22235 E\E/E'TT'NOT FOR
N5P-21 CORP
01- SULLINS
62 J11 - 1 PBCO4SAA | ELECTRONICS 222:314 E\E/E'TT'NOT FOR
N4P-21 CORP.
01- SULLINS PECO7
63 J14,J15 - 1 PECO7SAA | ELECTRONICS spaN | ACTIVE
N7P-21 CORP.
TOTAL 231

www.maximintegrated.com
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MAX32010 EV Kit Schematics
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MAX32010 EV Kit Schematics (continued)

ToTHLT

ano

T
+ANVSKZYYXYIN
vin

ova 100

“rzaszionm

£2va 100

o

2ova

Nwvsi0034 NwvS1003d ano
5va OTHL L B own =
R0 o1 T @0 oz am  aw
5va IS0l © B I
Sva Asor v | O o7 Asor =
— s L ey awo | ey
Va NIA_© B NR 5 %0 s wo e
BN o 0 VG AL Y anvsrzyrXVIN B T
— p o AL
ova D T T H1o anverernan n " BN B 0
ER Eq
ane ano ano
ano
YT = CLCCE I LLLLLLLL oo
T oz Tz e ano
88853802 88383 ano §5668 5585 8g°°
2385882 geog 8¢ EH
£55s
g8
& Tl [tnoa wee
e {1noa ez g5 |inoa we 0 E =
linoa sz L= o L= Tew e
A0S o 105 W10S[oT o8 o IS
[ I — ) e — o oo
SvaASOL G2 [84N0 8434 7z va 1o Sn ToTm 5z [8Ln0 8337z zovaino o 5 “ dan
sz [ino e e o Shn w0 w10
o) MO F ——s—ano
el ) ©ova S5S 5va 1501 8T Lno V434 oz EIva 110 ez THHL 8T N0 V3307 zowa o Hzz
TovawAn gt |viNO V438 g Vova 1o ez 2z o2y <
vou 5 i
= 3
8 [rte— e — R
vazzEsom o n 6n i fan on >
T &3 n oo e ano
ano
anot
1
anor
£
ano
3 o o o
Iy st ot T
ano ano ano ano ano  ano avo ano
ano ) ano 1 ano 1 ano 1
55 28] o anot 55 28] amo anot 55 98] o anor 55 98] o anot
85wl oo 3% wl s 35| el 1o 35| wl oo
anro lino T anro o T o o | anro Tjano un
b R at @ R a © - R 0 810 T R o
¥ova 1IN0 Lno N €ova 1no 9 no N Zova 100 9 e Tova 1o 9 e
o o o on
e pre—— pre——

Maxim Integrated | 16

tegrated.com

www.maximin



: MAX32010

Evaluates

MAX32010 Evaluation Ki

MAX32010 EV Kit Schematics (continued)
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MAX32010 EV Kit PCB Layouts (continued)

MAX32010 EV Kit PCB Layout—Top
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MAX32010 EV Kit PCB Layouts (continued)

MAX32010 EV Kit PCB Layout—lInternal 2
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MAX32010 EV Kit PCB Layouts (continued)

MAX32010 EV Kit PCB Layout—Internal 3
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MAX32010 EV Kit PCB Layouts (continued)
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Appendix
MAX32010 EV kit installer installs the MAX32010EvaluationKitGUl.exe (210KB size). Steps to install are as follows:
1. Click Next on the MAX32010 EV Kit GUI setup window.

5 Max32010 Evkit GUI

Welcome to the Max32010 EvKit GUI Setup Wizard [P

The installer will guide you through the steps required to install Max32010 EvKit GUI on
your computer,

WARNING: This computer program is protected by copyright law and international
treaties. Unauthorized duplication or distribution of this program, or any portion of it, may

result in severe civil or criminal penalties, and will be prosecuted to the maximum extent
possible under the law.

2. Select the Installation folder.

5 Max32010 EvKit GUI — X

Select Installation Folder ' |

The installer will install Max32010 EvKit GUI to the following folder.

To install in this folder, click "Next”. To install to a different folder, enter it below or click

"Browse".

Eolder:
CAProgram Files\Maxim IntegratediMax32010 EvKit GUR Browse...
Disk Cost...

Install Max32010 EvKit GUI for yourself, or for anyone who uses this computer:

(O Everyone
(® Just me

www.maximintegrated.com Maxim Integrated | 24
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3.

4.

Click Next to confirm the installation.

Evaluates: MAX32010

%5 Max32010 EvKit GUI -

Confirm Installation

The installer is ready to install Max32010 EvKit GUI on your computer.

Click "Next" to start the installation.

Installation process starts. Click Close after the installation.

19 Max32010 EvKit GUI —

Installation Complete

Max32010 EvKit GUI has been successiully installed.

Click "Close" to exit.

Please use Windows Updale to check for any critical updates to the NET Framework.

www.maximintegrated.com
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REVISION | REVISION DESCRIPTION PAGES
NUMBER DATE CHANGED
0 11/20 Release for Market Intro —

Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the US and/or elsewhere.

Windows is a registered trademark and registered service mark of Microsoft Corporation.

For pricing, delivery, and ordering information, please visit Maxim Integrated’s online storefront at https://www.maximintegrated.com/en/storefront/storefront.html.

Maxim Integrated cannot assume responsibility for use of any circuitry other than circuitry entirely embodied in a Maxim Integrated product. No circuit patent licenses
are implied. Maxim Integrated reserves the right to change the circuitry and specifications without notice at any time. The parametric values (min and max limits)
shown in the Electrical Characteristics table are guaranteed. Other parametric values quoted in this data sheet are provided for guidance.

Maxim Integrated and the Maxim Integrated logo are trademarks of Maxim Integrated Products, Inc.

© 2020 Maxim Integrated Products, Inc.
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